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Business Machines Corp.
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Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
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optical, chemical, manual, or otherwise, without the prior
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governmental laws and other regulations, such as copyright
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Warranty

The information contained in this document is subject to
change without notice.

Avision makes no warranty of any kind with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.

Avision shall not be liable for errors contained herein or for
incidental or consequential damages in connection with the
furnishing, performance, or use of this material.
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Federal Communications Commission (FCC) compliance
information statement
Part 15

The product has been tested and found to comply with the
limits for a Class A digital device pursuant to Part 15 of the FCC
Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference and (2) this
device must accept any interference received including
interference that may cause undesired operation.

The FCC Class A limits are designed to provide reasonable
protection against harmful interference when the equipment is
operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction
manual may cause harmful interference in which case the user
will be required to correct the interference at his own expense.

CE
Warning
This is a class A product. In a domestic environment this

product may cause radio interference in which case the
user may be required to take adequate measures.



Disposal of Waste Equipment by Users in Private Union

B

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. Fore more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.

As an ENERGY STAR® Partner, Avision Inc. has

determined that this product meets the ENERGY STAR
guidelines for energy efficiency.
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System Requirements

Windows

IBM compatible PC 586, Pentium or higher
Microsoft Windows 98 / 98SE / Me / 2000 / XP
USB port 2.0 (compatible with USB 1.1)

At least 500 MB of free hard disk space

At least 256 MB of system memory

A CD-ROM drive

YV V V VYV V V
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1. Introduction

Congratulations on your purchase of the color sheet-fed
image scanner. With this scanner, you can quickly scan
documents in duplex (double-sided) mode to increase
productivity.

Before you install and operate the new scanner, please take
a few minutes to read through this manual. It provides
proper instructions for you to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all the items, please contact your authorized local
dealer immediately.
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Scanner Main Unit

ADF Paper Tray

ADF Output Paper Tray

USB Cable

Power Adapter & Power Cord

arONPE

Note:

1.

Only use the AC adapter HEG42-240200-7L (made by HiTron)
included in the machine. Using other AC adapters may damage
the machine and void the warranty.

The suitable power supply cord will be provided and
evaluated when national approval.

Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.
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2. Scanner Installation

Precautions

= Keep the scanner out of direct sunlight. Direct
exposure to the sun or excessive heat may cause
damage to the unit.

= Do not install the scanner in a humid or dusty place.
= Be sure to use the proper AC power source.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

= Retain the scanner box and packing materials for
shipping purposes.

2-1



2.1 Installing the Input Paper Tray

1. Pull the ADF Release button to open the front cover.

?"n‘;” X T
R e
o =

I ADF Release
. ' Button
/ Front Cover
2. Insert the pin with a inclined plane on the right side of

the Input Paper Tray to the hole on the rear of the
scanner as illustrated.

, L Right Side

’* B \ y Input Paper

2| Tray
/
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Use your left thumb to press the place near the pin
with a inclined plane of the other side of the Input
Paper Tray and then insert the pin to the hole of the
scanner as illustrated.

Press the
place near
the pin

Hole

Pin with a
inclined
plane
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2.2 Installing the Output Paper Tray

1. Insert the smaller pin of the left side of the Output Paper
Tray to the hole on the front of scanner as illustrated.

Output Paper
Tray

2-4
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2. Use your thumb to press the place near the pin of the other
side of the Output Paper Tray and then insert the smaller
pin to the hole on the scanner as illustrated.

Press the
hinge area

Hole

The
smaller

pin
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2.3 Installing the Scanner Driver and Cables

Note:

1. The Windows system CD may be required when installing
on some PC’s.

2. To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

2.3.1 Connecting to Power

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

Power Cable

2-6
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2.3.2 Turning on the Scanner

1. Press the Power Switch button on the front panel, the
Power LED will flash. When it is finished and ready to
scan, the LED indicator will stop flashing and become
steadily on. To turn off the scanner, press the Power
Switch button for about 3 seconds, the Power LED will
be off.

2.3.3 Installing the Scanner Driver

1. Place the supplied CD-ROM onto your CD-ROM drive.

2. The software installation graphic appears. If not, run
“setup.exe”.

CD Setup

AViSiOI‘I www.avision.com

A vision of your office

To ensure the buttons work properly on the scanner, please FIRST install
Button Manager before installing the scannesdriver.

Install Button Manager

Install Scanner Driver

Install Adobe Reader

View Manuals
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Contents on the installation graphic:

¢ Install Button Manager: To use the buttons on
the scanner, you need to install Button Manager. To
ensure Button Manager works properly, please FIRST
install Button Manager before installing the scanner
driver.

e Install Scanner Driver: To communicate with your
scanner, you need to install the scanner driver.
After installing the Button Manager software, click
Install Scanner Driver to install the scanner
driver on your computer.

e Install Adobe Reader: To view the user’s manuals
for the scanner and Button Manager, you need to
use Adobe Reader to open and view the manuals in
pdf file format. If you already have Adobe Reader

installed on your computer, you may disregard this
item.

¢ View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner and
Button Manager respectively.

3. Click Install Button Manager to install the Button Manager
software and then click Install Scanner Driver to install the
scanner driver on your computer.

2-8
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2.3.4 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port of
your computer.

2. The computer should detect a new USB device and prompt a
“New Hardware Found” message.

New Hardware Found

USE Scanner

‘Windows has found new hardware and is locating the software far it

(Windows 9X/Windows ME)
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3. In Windows 98SE, Windows ME, or Windows 2000,
confirms that the “Search for a better driver.” is
selected and click the “Next” button.

Add New Hardware Wizard

“Windows has found the following new hardware:

USB Scanner
Windows can automaticaly search for and irstall software
Htat supports bour hardware. |F your hardware came with

installation media, insert it now and click Mext.

What would you like to do?

£ Butomatic search for a better diiver [Hecammended]

' Specify the losation of the diiver (Advanced)

ciack [ Mews | Cancel

In Windows XP, click the Next button to continue. When
the XP certification screen appears, click Continue
Anyway to complete the installation.

At this moment, the “Found New Hardware ” wizard
will display again. Follow the same steps to complete the
installation.

Important!

Please note for this model. Your computer will identify
two USB devices. You have to install “Found New
Hardware > wizard twice to complete the installation.
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4. When the Finish dialog is prompted, click the Finish
button.

5. Click “View Manual” to view or print the detailed user
manual for the scanner and bundled applications
respectively.

Note:
To uninstall the scanner driver in Windows XP or Windows 2000, be
sure to keep your scanner connecting to your computer.

2-11
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3. Completing Your First

3.1

Scan

Loading Your Paper

3.1.1 Notice on Using the ADF

Before using the ADF, please make sure that your paper meets
the following specifications:

Document(s) can range in size from 3.5 by 2 inches

Document(s) can range in weight from 16 to 34 lbs (60 ~
127 g/m?)

Document(s) should be square or rectangular and in good
condition (not fragile or worn).

Document(s) should be free of curl, wrinkle, tears, wet
ink, or punch holes.

Document(s) should be free of staples, paper clips, paper
sticky notes.
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3.1.2 Placing Your Document in the Input Paper Tray

Fanning Your Document

Standard paper size should feed easily through the scanner.
To avoid occasional paper jam when automatically feeding
multiple documents, loosen the paper before loading.

Document feeding

Place your document with the text face down on the ADF
Paper Tray. Align the two sides of the document with the
slide guides. Please note that the ADF Paper Tray can hold
up to 100-page (60 ~ 65 g/m?)document at a time.

Your
Document

Slide Guide

3-2
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3.2 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start=Programs=>=Avision AVxxx Scanner=>Avision
Capture Tool.
The Select Scanner Model dialog box will be displayed.

Select Scanner Model EI

Driver Type:
ThfAlN

Scanner Model

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.



5.

Fit Actual
Page Size

& Avision Capture Tool (TWAIN) - Avision AVxxx
Fle View About

: L] | . T
4 @Sﬂup VI Scan Ij | F)]lz Format BMP v [Ciby Scamimags

| |
' . Save File Path
File Format
Scan

Setup

Choose your desired file format from the File Format drop
down list box. (Default is BMP, other choice includes TIFF,
GIF, and JPEG.)

Type your desired folder name and file name in the File
Path box. (Default is C:\My Scan\Image.)

Note: If you do not wish to save the scanned image,
deselect the Save button since default is Save Enable. In
this case, the thumbnail view will be disabled. And
therefore, after viewing all the scanned images, only the
last one will remain on the screen.

‘ﬁ._ He
Click the Setup button ( WJ tLllJ) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.
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10.

Imaze | Compression | Color Drapout| Baper | Ereview | Options | Seting | Information |
Image — - -
H [Rear B&W .
Selection i Brghes 04 | 2
Contrazt (I ] »
Box 5l |
Resolution (3pd) : 200 -
Tnvert: Black oz White -
Scan Source: [Automatis a|
Profils | [Costom =1
I Color Adjustnent
Defaults. 0K Close

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

Sran
( o ) or choose Scan from the File menu.

The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.
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EE Avision Capture Tool (TWAIN) - Avision AVxxx

File ¥iew Abont

@Semp f Sean

% BleFomst  |BMP | [City Scaniimage | |@ D

A n\dmuﬁa

4 4 &

=

%%
m
P = T
e

I
— =

i OV

Fife Neme:Image_001 binp, Image Type Color, Width: 1640, fength 2339, Resoluion:200 dpi, Image §zeil 1507 88 Khytes

' Status Bar ' Fit Page View

Thumbnail View

. You can view the scanned image in Fit Page (‘Q‘) or
Actual Size (100%) button (D ) from the Viewing toolbars
at the right side.

. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.
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3.1.3 A Glance of the Scanner Properties Dialog Box

1 — e | Compression | Color Drogout | Baper | Preview | Options | Setting | Information |
Ross Cobr T e |
[ g bl
> —T e 0 .
Controst : 04 | vl 4
Reslution (g o = | 5
Invert [BockonWhie ] 6
Soan Soumce: |Automnatic - 7
pucies | [Cosom =l
™ Color Adjustment
8 — | Defuls 0K Close

1. Tab Options |[Choice: Image, Compression, Color Dropout,
Paper, Options, Settings, Information.

2. Image Choose your image type and the side of
Selection Box |[document you wish to scan. Options vary
based on type of scanner.

3. Brightness: Adjust the brightness level from —100 to +100.

4. Contrast Adjust the contrast level from —100 to +100.

5. Resolution Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source |Choice: Auto Document Feeder, Flatbed,
Flatbed (Book), Automatic (varies due to
different scanner model)

8. Defaults Reset all values on the tabs to the factory

default settings.
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

Scanner Froperhies g'

Image ]Compmﬁion] Color Dmpout] Paper ] Preview ] Opﬁom] Sething ] Infonmtion]

Tk e
[ 1Rear T | J
[ |Front Gray
[ 1Rear Crray J J
[wlFront B&W
[Rear B2 Erightness: 04 _ 2
Contrast: 0 ﬂ J ﬂ
Resolution (dpi): [200 =]
Invert: |Black on White j
Sean Source: |Auh0maﬁr. ﬂ
Profiles |Cu.s1nm ﬂ
[ Color Ldjustment

Defaults... Scan | Close

The Scanner Properties dialog box



4.1 Buttons on the Scanner Properties Dialog Box

Scanner Properties El
Tmage ICompressmn] Color Dmpout] Paper ] Preview ] Oph.onsl Sething ] Infomh.on]
| ]
[ Fromt Grray
[ Rear Gray J J
[wFront B&W
“Rear B&W Erightness: 04 n 2
Comtrast: 1] ﬂ J ﬂ
Resolution (dpi): [200 ] _
Invert: |Black on White ﬂ
Sean Source: |Au1nmatn: j
Profiles |Cu51nm ﬂ
[ Color &djustment
Defaults Scan ‘ Cloze |

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Scan After all the scan settings are satisfactory, click
the Scan button to start scanning your
document.

Close Click the Close button to leave the Scanner

Properties dialog box.
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The following table shows the default settings :

Tab name Default settings

Image Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression None

Color Dropout | None

Paper Cropping : Automatic
Deskew : Yes

Orientation : Portrait
OverScan : 0.00

Multifeed Detection : None
Unit : Inch

Options Rotation Degrees : None
Blank Page Removal : None
Edge Fill : White > O mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15
minutes after last scan action
Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes

43



4.2 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

Scanner Properhies E|
Image lComprea&on] Colox Dmpout] Papex ] Preview ] Opﬁom] Setting ] Infonmdion]
Dear Color | J
[ |Front Gray
[ Rear Gray J J
[w]Front B&W
[|Rear B&W Erightness: 04 u |
Contrast: 1] ﬂ J ﬂ
Resolution (dpi): |00 3]
Tnwvert: |Black on White ﬂ
Sean Source: |P,uh3matic ﬂ
Profiles |Cmm ﬂ
[ Color Ldjustment
Defaults... Scan Close

The Image tab dialog box



User’'s Manual

4.2.1 The Image Selection Box

T | B B | The Image Selection box includes
the image type and document side
option. If you wish to scan both the
front side and the rear side of your
color document, you can check both
Front Color and Rear Color at the
same time. Note the options vary
based on type of scanner.

Example 1 : Scanning a two-sided color document, both
sides in color

Side/Image ]
Selection




Example 2 : Scanning a two-sided color document, one
in B&W(Drop Blue Color : Threshold : 10, Background :
79), the other in color

Side/Image .

Selection Front Rear

Image Type | Description

Color Choose Color if you wish to scan a color
image for your original in color.

Gray Choose Gray image if your original contains
actual shades of gray.

B&W Choose B&W if your original contains only text
pencil or ink sketch.

B&W Gray

4-6
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4.2.2 Other Image Options

Binarization

This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Two of the options are Dynamic
Threshold and Fixed Processing.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Fixed Processing: Used for black-and-
white and other high contrast documents.
A single level is set to determine the
black-and-white transition. The threshold
is programmable over the entire density
range. Fixed Processing sets Contrast
to 0. If Fixed Processing is selected,
Contrast is not available.
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from O to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

200 dpi, 200 dpi,
Threshold:80, Threshold:170,
Brightness: O Brightness: O

4-8
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from —100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from —100 to +100.

a-;..-' :

Brightness: -50 Brightness: O Brightness: +50
(Normal)

Contrast: -50 Contrast: O Contrast: +50
(Normal)
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Resolution

A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the
right side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list.

-
Resolution: 75 dpi

Resolution: 150 dpi

4-10



User’'s Manual

Invert

Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“E am not worthy to have you enter my

:that is God, I beq all my brothers - those w
e who work manuaslly, clerics and lay brothers
ards belng humble in all things; nat to glorify
r to become interlorly proud because of good w
sametimeas says or does in them or through tl
ard:  “Do not rejoice--- in the fact that the de
£ 10:20} Let us be firmly convinced of the fact

Black on White

“I am not worthy t¢ have you enter m

that is God, I beg all my brothers - those v
E who work manually, clerics and lay brothe

rds being humble in all things; not to glority
to becorne Interlorly proud because of gand
sometimes says or does in them or through 4
rd:  “Do not rejoice--- in the fact that the dd
10:20) Let us be firmly convinced of the fa

White on Black
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several
inside pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is document in both the auto
document feeder (ADF) and the flatbed, then
the scan source will be automatically set to
ADF. If Automatic is selected and there is
document only in flatbed, then the scan
source will be set to flatbed.

Note the options vary based on type of scanner.
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Color

Adjusts the color quality of the image so
Adjustment

that it comes close to that of the original.
This function uses default parameters to
adjust the image.

After Color Adjustment

4.2.3 Scanning color images

The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert
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4.2.4 Scanning grayscale images

The following options are available for scanning gray images.

. Brightness

. Contrast
. Resolution
. Invert

4.2.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)

. Threshold

. Brightness
. Resolution
. Invert

4-14
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4.2.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1.

Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

Edit Four Profile fEX

Brofile: - Delst
? Rename Reset

Doty Scan Clene:

Click “Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Fleaze enter the name of the profile:

Save | Cancel |

The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit ¥our Profile EJ @‘ E‘

Profile:

ot
Simplex - B&W, 200dpi
Simplex - Color, 200dpi
Simplex - Crray, 200dpi

Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profils

Rename Reset

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you
want to delete this profile?” is prompted.

Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,

1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profile:

ot
Simplex - B&W, 200dpi
Simplex - Color, 200dpi
Simplex - Crray, 200dpi

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.

Rename a Profile gl

Pleaze enter the new name of the profile:

Origina] Nome: | Beteyr

Wew Wame: |

Caneel |

4. Choose “Save” to save the new profile or “Cancel” to quit.

Note:

The preset default profiles include Flatbed, Simplex-B&W, 200
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If
you have a simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.
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4.3 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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Scanner Properties ‘

Imege  Compression NCD].DI Dropout | Paper | Preview | Options | Setting | Information. |

[ Fromt Calar
(R ear Color
[ |Fromt Gray
[ JF.ear Gray

[ F.ear B&W

Comnpression:

| o) =]

l—

Defaults...

Scan Close

The Compression tab dialog box

4-19



4.4  The Color Dropout Tab
4.4.1 Color Dropout Selection

Color Dropout tab allows you to drop either of the red, blue, or
green color in your scanned image. If your image contains red
color watermark or background, choose the R (Red) channel
then any red watermark or background will be removed. This
feature is used to sharpen your text when using OCR (Optical
Character Recognition) software.

Note that this function supports only black & white and gray
images. Therefore, be sure to choose any black & white or
gray image type while applying this function.

Scanner Properties |

Imoge | Compression Color Daopout | Faper | Breview | Options | Setting | Information |
[Front Color
Rear Color Caolor Dropant: |Remave Red =]
[_Front Gray Sy
[ Rear Gray
Filter Threshald: 0 4 J ﬂ
[CIRear B&W J J
Defaults. Scan Clase

The Color Dropout dialog box
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4.4.2 Other Color Dropout Options

Advanced Processing provides two options that can adjust
your scanned image in the best optimal result.

Filter This value is used to determine the color

Threshold which will be dropped out. A lower value will
drop more of the selected color out, while a
higher value will leave more of the selected
color in.

Background The pixel which is higher than the

Level background value will be adjusted to the
lightest point. Adjust the value for both the
Filter Threshold and Background Level to
produce the best optimal result.

Example, slightly adjusting the background value makes
your text more clear.

AMB120EESIHERSIIRE

Original
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Remove Blue, Threshold: 20, Background:
255

AME120F: B B IIIEM S MG

Remove Blue, Threshold: 20,
Background Level: 210
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4.5 The Paper Tab

The Paper tab allows you to define values relating to image
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed

Detection).

Scanner Properites

Cropping:

Scan Area:

OverScan:

Unit:

Multi-Feed Detection
¥ Addiional Length Detection:
[ Ultrasonic Detection:
I~ Stop Scanning after Multi-Feed
Moulti-Feed Alsrm:

hd
r F
| (tone) =1/
+ Portrait e
=l
-Oifset e &
Y-Offsnt; 0.00- ;J g |
ik 2= =z
Width: 826~
Length: 1169 7 Conter
=1
=1
Top: I].UEI:“:_JJ Bottom:
|
0.00-+

(Mone)

|Inches

Image | Compression | Color Dropout Paper | Preview | Options | Setting | Information |

X

Defaults...

Scan

Close

The Paper tab dialog box
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4.5.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Fixed to
Transport, EOP (End of Page) Detection.

Options

Description

Automatic

Automatic adjusts the cropping window
according to different document sizes. Use
this option for batches of mixed-sized
documents.

Fixed to
Transport

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of
Page)
Detection

This feature allows you to define the area
or zone to be imaged. Use for batches of
same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

. Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.

o

. — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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Example : Redefine your scan area ( x-offset: 2.25 inches ; y-
offset:1.13 inches)

Scanner Properties X
Image | Compression | Color Dropout Paper | Previsw | Options | Setting | Information |

Cropping: [Fiowed o Transport -
r Scan

Scan Area: (Hone) = . Area
= Portrait &
X-Offsct: 225-4
V-Otfaet: 113 L?

= hd :
i 6 Display
Length: 713 [ Contor .
— = window

OverScan: e 2 =1
Top: 0.00- Botiom: 000+

Multi-Feed Detection

% Additons] Length Detection: 202

I™ Ultrasonic Detection:

[~ Stop Scanning after Multi-Feed
Molti-Feed Alarm: (lone) = ¥ Bove. |
Unit: [tnches =
Defaults . Scan Close

Original After Fixed to
Transport

The Redefined Scan Area
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4.5.2 Other Paper Selection

Deskew

Use this option to automatically deskew a document.

| KOHIKANSEIR N

Note: If the skew angle is
ZE8 s too great, some of the
= image may be cut off.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choice: None, US Letter- 8.5”x 11”, US Legal — 8.5” x 14”,
ISO A4 — 21 x 29.7 cm, ISO A5 — 14.8 x 21 cm, ISO A6 — 10.5
X 14.8cm, ISO A7 — 7.4 x 10/5 cm, ISO B5 — 17.6 x 25 cm,
ISOB6 —12.5x 17.6 cm, ISO B7 — 8.8 x 12.5 cm, JIS B5 —
18.2 x 25.7cm, JISB6 —12.8 x 18.2cm, JISB7 — 9.1 x 12.8
cm, Scanner Maximum, Long Page.

Long Page:

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be available.
Options: Unknown Length, Enter Length (Note: This option
varies due to type of scanner.)
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Choose “Unknown Length” if you have a batch of long page
document with unknown length. Choose “Enter Length” to
enter the length and width of your documents or your desired
scan size on documents. This is useful when you have a batch
of documents with the same scan size or a batch of same-sized
documents.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value between 0 and +5 mm. Note the overscan
result will not be shown in the Display window and that the
availability of the function varies based on type of scanner.

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of

the function varies based on type of scanner.

Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of O indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.
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Example : Additional Length Detection : Set Additional
Length to be 2.02 inches

Scanner Properties @

Image | Compression | Color Dropout  Paper | Preview | Options | Seting | Information |
Cropping: | Fixed to Transport |
I Deske
Scan Ares: | Mone) 2 |
@ Portrit € Londs:
E-Offst 225 P
T-Offset 1.133J —‘—f 1 2.02”
Widih 628
Length: 7-]3j I~ Center
: =l =i
OverScan: = =
Top: U-mﬁ Bottom: 0.00:‘
Multi-Feed Detection
v Additional Length Detection: 202-
[~ Ultrasonic Detection:
I Stop Scanning sfter Multi-Feed
Multi-Feed Alsom: one) = | Brows..
Unit [Inches ]

Detaults.. Scan Close
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Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note : The
availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder and
display the following Warning dialog box if multi-feed is
detected.

' E Multifeed iz detected, please remove the rest paper from ADE.
[

Action:

1. Follow the instruction on the Warning dialog box to
remove the rest pages on the feeder.

2. Click OK to close the Warning dialog box.
3. Scan the rest pages.
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e Sound Alarm on Multi-Feed

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

If “Stop Scanning after Multi-Feed” is selected, the scanner
will stop the feeder.

If “Stop Scanning after Multi-Feed” has not been selected,
the scanner will continue to scan till the end of your
document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow
the action described in the preceding section “Stop
Scanning after Multi-Feed” on the previous page to
complete your job.

2. If “Stop Scanning after Multi-Feed” has not been
selected, rescan the pages where multi-feed is
detected.

How to add the sound alarm:

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.

3. Click the Open button. The wave file is added.

Units
Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.5.3 Relative to Document

Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph, or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, 1SO B5. If you have not chosen a scan area
and leave the selection as None, then the default area will
be the scanner’s maximum.)

|
lmage | Compessaon | Colos Dwopont Poper | Pevvarw | Oyt | Seting | ot |
R T —
2 | wwam 531;:;“ : il —_— A red
Yo S rectangular
o 3|
Wit | bOX

Length

e +
Top 0100 Botm am-
[T ——
W Al Length Detes o 0003
v Wewor: Dedechion.
i0p Towmneng afier Muls-Peed
Hielts Ford Al Dicee) =] ¢ Bows |
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

The Image
Selection
Box

Scanner Properties

3]

Image | Composssicn | Colos Doopount | Papes  Foview | Optioas | Suting | Indfocmation

o Gy

P AW

The selected
image

A black
rectangular
box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

Image | Compression | Coloe Dmpout | Paper  Tavview | Opsioea | Seting | Informasion

Froat Gavy

o Frust EAH

0 1 I 3 4 8 8 T 8 B
Ll

e | Soan com |

The Preview
Image

The Preview
Button

Select image type from the Image Selection box. The

selected image will appear in highlighted color. (For
example, Front Color)

Place your cursor on the Preview window and click your

left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected

area will appear in a red box as illustrated.
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A Cross

Sign

Image | Comgeasn | Color Drspont | Paper

Povvirw | Ciptoe | Zeming | Infoemation |

Frset Geny

et BAN

Somn e

() =
fortt Lutinpe

Tttt 20

Totmm 19

LTS <

Leagh 1w

= = =]

b | 2

The
Relative
Area

Check the B&W image from the Image Selection box to
scan the entire document.
Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)
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The entire document in B&W
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4.6 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

Scanner Properties EI

Tmage ] Compmmn] Color Dmpouﬂ Poper  Prewiew WOphom] Setting ] Infonmhoﬂ

The Display
Window
Bean Area
(Mone) =
& Portmit " Landsweape
T-Offet 240
Y-Offset 129
With - 2914
Length: 2592
nit : Inches -
Defanls...

Sean Close

The Preview Tab
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4.7 The Options Tab

The Options tab allows you to set following additional image
processing settings.

Scanner Properties f5_<

Image I Cnmpnemiﬂn] Cn]nrDmpnutl Paper ] Preview Cptions ISeth'ng } Infﬂmﬁnn}

Rotation

Rotation Deguees -
Blank Page Removal

[~ Blank Page Removal Threshold: J

Edge Fill

(+ White
0 Millimeters

" Black
Image Control Options
[~ Minmr
Background Setting
{+ White Background " Black Background

Defaults.. Scan ‘ Close

The Option tab dialog box
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Flip Side Select “fanfold” to rotate the image
Rotation of the reverse side to 180 degrees.

This is applied to double-sided
document which are viewed in
portrait are sometime fed into the
scanner in landscape or vice versa.

Choice: Book, Fanfold.

If “Book” is selected, the image of
the reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

k]
B g g2 2 I
i 3 g7 S B
} Ly - BB
EER e cEE ]
Eodels 7 ) -
%‘.s;:g 0 £ ! b &
N ’ »/ 53 £

(5 2 5

g A E

i i

q g

| g

e

(3

=

an

1

bt |

4-37



Rotate Image Choose the rotation angle from the
drop down list if you wish to rotate
your scanned image.

Choice: None, 90°CW/(clockwise),
90°CCW/(counter clockwise),
180°.

123

¢C1

Original
rigina Rotate 90°CW

¢ C1

123

Rotate Rotate 180°
90°CCW

Blank Page Check if you wish to remove the

Removal blank page and move the slider to
the left or right to your desired
threshold.
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Edge Check White or Black if you wish to add white or

Fill black edge on the border of your scanned
image. Enter the value from 0 to 5 mm. Default
value is 0.

Original

Image Check the Mirror box if you wish to reverse the
Control right and left side of your image.
Option

W

ot

The Mirror Eect
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Background
Setting

This option allows you to set your scan
background.

Choice: White Background, Black
Background.

*This option varies based on type of scanner
and is available for the front page in the ADF
(auto document feeder) only. For the rear
page, only the white background is
available.

3 | B
White Background

3
Black Background
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4.8 The Setting Tab

The Setting tab allows you to set the following settings:

Scanner Properties &

Image] Eompression] EolorDropout] Paper ] Preview] Options  Setting ] Information]

Energy Saving Control

ﬂ J ﬂ 15 mirutes

Barcode Detection
I” Enable

[v Ehow Scanning Progress
[v Ehow Warning Message
[v Bave Settings after Closing

Defaults... Scan Close

The Setting tab dialog box

Energy Saving Check the Enable Energy Saver box

Control and move the slider to the right to set
the amount of time to start the energy
saver after your last action. The range
is from 1 to 240 minutes. The default

is 15 minutes.
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Batch Scan
Setting

eBatch Scan

To increase the scanning speed, the
scanner first scans a few pages of your
document and then sends these scanning
data to the application. Therefore, during
scanning, the numbers of pages been
scanned on the scanner is somehow
different with the numbers of pages
displayed on your computer screen.
Choose this mode if you wish to complete
your scanning task at the fastest speed.

ePage Scan

If you choose Page Scan, during scanning,
the scanner will first scan only one page of
your document and then send the scanned
data to the application and then scan the
next page and send the next data to the
application, and so on. Therefore, in this
mode, the scanning speed is slower yet this
helps to keep the same scanning progress
between the scanner and your computer
screen.

Barcode
Detection

Check this option to enable detecting and
recognizing barcode in your document.
After the detecting process, an
avbarcode.ini file will be generated and
stored in your system drive, for example,
Windows\avbarcode.ini.

Note: The availability of this feature varies
based on type of scanner.
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Show Scanning | Check and the scanning progress bar
Progress will be shown during scanning.

Show Warning | Check to show the warning messages
Message such as “ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings Check to save your scanner properties
after Closing settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.
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4.9 The Information Tab

The Information tab displays the following system and scanner
information.

Scanner Froperties El
Image ] Compression } Color Dropout I Paper } Preview ] Options I Setting  [nformation I

Port Tupe B ~

1D/ Address: URE

Optical Resolution: 600 dpd

Scammer Model: AN

Serial Nuimber: G20CN1065M5T1400052

FW Version: 0.180

Background: White Background

Bomn Date: 20065/

First Scan: 20067744

ADF Fad Count: 142 Reset Pad Count |

ADF Roller Count: 138 Reset Roller Count |

ADF Count 137

Flathed Count: 463

Multifeed Count 3052404277

JTam Count: 730247176 v
Report
Defaults.. Close

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file (C:\AVxxx) will be
generated. Please send this file to the nearest service center
for trouble shooting.
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The “Reset Pad Count” button |

After scanning approximately 50,000 pages (the number varies
based on type of scanner) through the Auto Document Feeder
(ADF), the ADF pad may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF pad with a new one. (Please
refer to the manual for proper replacing procedure.) For
ordering the ADF pad, please consult your nearest dealer.

After replacing the ADF pad, click the “Reset Pad Count”
button to reset the pad count.

The “Reset Roller Count” button |

After scanning approximately 200,000 pages (the number
varies based on type of scanner) through the ADF, the ADF
roller may be worn out and you may experience problems with
document feeding. In this case, it is highly recommended to
replace the ADF roller with a new one. (Note the replacement
of the ADF roller has to be performed only by authorized
service center. Therefore, please return your scanner for roller
replacement.) After replacing the ADF roller, click the “Reset
Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner. Please consult your nearest dealer for more details.
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5. ISIS Interface Operation

The ISIS driver operation method is similar to the TWAIN'’s.
Every function on the ISIS interface screen is briefly described
as below:

; Brightress
B 5
|Black and White j * Manual = Aut
Default
Wl = uilEicE #
Cancel
Darken I Morm I Lighten I

Dotz per inch;

|SDD j | Area..
Page Size: LContrast-

[45-14.8%21.0cm | | Manual e

FI=DFLT Yersion 55.1.260.851 =a = E 128

Avizion PN Driver Y2.01.062402

Mode: Select one of scan modes, including B&W, gray, color
options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the
lightest shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using the Buttons

The following picture shows the 4 buttons and 1 function

screen on the scanner.

Function
Screen

Power

Scan

©
%]
c
=}
L]

Function

6-1

Power Switch

Scan Button

Cancel Button

Function-Select
Button



6.1 Installing Button Manager

To use the buttons on the scanner, you need to install the
Button Manager. To ensure the Button Manager work properly,
please FIRST install Button Manager before installing the
scanner driver.

Installing the Button Manager is easy. Insert the supplied CD
to your CD-ROM drive and follow the instructions on the screen
to complete the installation of the Button Manager.

Button Manager provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.

6.2 Checking the Button Configurations Before Scanning

1. Click the Scan button on the scanner.

2. The Button Panel is displayed in the Windows System Tray
at the bottom right corner of your computer screen.

/ This indicates the scanner model

: x|

H @ Archive B

S
— | [ The Function

H =R Icon

H ‘E,/ W (The number of
¥ function icons

S i vary based on
® o | bpeo

scanner.)
The Button = qj;,",r: 02:06 P

Icon
The Button Panel
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

Click to select

~options or
Buiton Properiies g‘ Sgttl ng A
Menu | Options || Setting
The button Chagss 4 caufiguiation The scan
3 s W) B&W, 150 A4, 200dpi = .
Egmger and [ Archive settings for
. Chooss a destination:
& the selected
G button. (in
this case
button #1).
The file The destination
format of the application.
scanned ——— [ Adobe POF Properties | [ Add/Delete | (This is the
image. (*The 7|~ a2l nl & 8l e licati h
. #| | & & & application that
options vary ﬁﬁﬁ@ﬁ opens after you
based on have finished
type of scanning.)
scanner.)

The default setting is indicated in highlighted color. If you
wish to change the setting, use this window to reset the
setting for the file format, destination application, or other
scan settings. See “Configuring the Button” in the
subsequent section to reset the settings.

4. Click the OK button to leave the window.

6-3



6.3 Scanning From One Touch of the Buttons

1. Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document
feeder.

2. Check the number on the LED screen to ensure if you are
selecting the proper scan settings and destination
application. (For example, if you want to scan with button
#4, which open Microsoft Paint and display the scanned
image in the main window of Microsoft Paint, the LED
screen should show 4).

3. Press the Scan button on scanner.

4. After the scanning is finished, the Microsoft Paint software
will be launched and the scanned image appears in the
main window of Microsoft Paint as below.

o General Document foding mode Fiatbed.
4’ T T —
h . Scanningspeed
i ﬁ:‘nnn papas sizo
ADF max. paper size
Fiatbed max, paper size
B e
__ ;}:‘:‘:nmms:n xWxD)
Weight
Copy First copy out | Colar mods
Spec Color copy speed
BW capy speed
_Copy resolution
. Copy scaling |
Muftiple copies -
[ mepmaegaeasans
Note:

For details information on how to use the Button Manager,
please refer to the user’s manual in the supplied CD.
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7. Maintenance

7.1 Cleaning the ADF

From time to time the pad assembly and feeding rollers may
become contaminated with ink, toner particles or paper
dust. In this case the scanner may not feed documents
smoothly. If this occurs please follow the cleaning
procedures to return your machine to its original state.

The Cleaning Procedures

1) Soak a clean lintless cloth with some isopropyl alcohol
(95%).

2) Press the ADF Release button on the upper. Open the
front cover slightly to the left. Wipe the upper feeding
roller with the cloth from side to side. Rotate the roller
forward with your finger and repeat the cleaning steps
above until the entire roller is cleaned.

3) Wipe the ADF pad and roller.

4) Close the scanner front cover. Your scanner is now ready
to use.

ADF Release
Button

Front
Cover




ADF Roller

ADF Pad

ADF Roller
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7.2 Cleaning the Calibration Area

1. Press the ADF Release button. Open the front cover to the
left.

2. Wet a clean lintless cloth with some isopropyl alcohol.
(95%)

3. Wipe the glass and the white area as illustrated in below
from side to side to rid the dust or dirt.

Calibration
Area

Glass
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7.3 Replacing the Snap-in Pad Module

After scanning approximately 100,000 pages through the ADF,
the pad may be worn out and you may experience problems
with document feeding. In this case, it is highly recommended
to replace the pad module with a new one. For ordering the
pad module, please consult your nearest dealer and follow the
procedure below to replace it.

Disassembling Procedure

1. Use your left thumb to pull the ADF Release Button on the
top of the ADF (auto document feeder) unit.

2. Gently open the ADF front cover to the left.

3. Use your right thumb to push the ADF pad module to the
right as illustrated to remove it.

&

ADF Release
Button

ADF Pad
Module

Assembling Procedure

1. Locate the position of the ADF pad module (beneath the
ADF Release Button button).

2. Place the ADF pad module into the holes until it snaps
into place.
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8. Troubleshooting

8.1 Clearing a Paper Jam
In the event of a paper jam, follow the procedures below to
remove the paper:

1. Pull the ADF Release Button on the left side. Gently open
the front cover to the left.

2. Carefully pull the paper out of the ADF unit.

3. Close the scanner front cover. Your scanner is now ready
to use.
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8.2 Questions and Answers

Question: Paper becomes jammed during scanning.
Answer: 1) Open the scanner front door.

2) Pull out the jammed paper carefully.

3) Close the scanner front door.

Question: More than one sheet of paper are fed into the
scanner.
Answer: 1) Open the scanner front door.

2) Remove the multi-fed sheets of paper.

3) Close the scanner front door.

4) Flatten the corners and edges. Loosen the
paper before putting it into the paper guide
again.

5) Check the feeding roller condition. If
necessary, follow the cleaning directions in
section 5.1 and perform the cleaning.

Question: Paper becomes skewed in the scanner.
Answer: 1) Use the slide guide to keep the paper path
straight.
2) Check the condition of the feeding roller. If
necessary, follow the cleaning directions in
Section 5.1 and perform the cleaning.
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Question: Why is it my scanned image always comes out

too dark?

Answer: 1) Modify the Gamma setting to 1.8 for your

2

Question:

Answer:

Question:

Answer:

monitor and, when printing, set Gamma to 2.2
for your printer.

) Use the Brightness setting of the TWAIN user
interface to get a brighter image.

Sometimes it seems the scanner does not detect
paper?

The scanner paper sensor is located at the center
of the paper guide. Please place the document
you need to scan on the paper guide and use the
slide guides to keep the paper path straight.

When | choose optical resolution to be 600 dpi,
the "auto crop™ and "deskew" functions will be
disabled.

Since to perform auto crop and deskew
consumes great deal of system memory, it is
suggested if you wish to perform "auto crop" and
"deskew" functions, please choose your optical
resolution to be smaller than 600 dpi to prevent

a error message.
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8.3 Technical Service

Before contact Avision, please prepare the following
information:

®m  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, Inc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com
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9. Specifications

All specifications are subject to change without notice.

Model Number :
Scanner Type:
Optical Resolution:
Scanning Modes:

ADF Capacity:
Document Size:

Min. Document Size:
Paper Weight:
Interface:

Power Source:
Power Consumption:

Operation Temperature

Dimensions: (WxHxD)
Weight:

FT-0807H

A3 sheet-fed Scanner

600 dpi * 600 dpi

Black & White

Gray

Color

Up to 100 pages

A3, Letter, legal, A4, B5, A5,
business card

3.5" x 2" (ADF)

16 Ibs. to 34 Ibs.
Hi-speed USB 2.0
24Vvdc, 2.0A
<38.4W (operation)

<20.4W (standby)
10°C ~ 35°C

420%250%216mm
9.9 kgs
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